
This Mission Editor tool is a slightly modified version of the actual tool used by NovaLogic Mission Designers. Although
some of the campaign programming has been disabled, you will find this tool extremely flexible when it comes to
designing your own missions. This manual will only cover the basic requirements for successfully creating a mission.
Because mission design has so many complex components, this tool is intended for the advanced user.

Use at your own risk.
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The Mission Editor Tool requires a minimum screen resolution of 800x600. For best results, we recommend that you set
your resolution to at least 1024x768. It is also recommended that you have at least 160 megs of memory free when
using the tool.
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Section 1: Navigating the Tool
There are a number of keyboard controls and toolbar buttons that will help to create missions more efficiently.

Mouse Commands:
Left Button – Selects or unselects an item in Select Mode or Inserts a new item in Insert Mode. You can left click on the
Unselect All button or you can hit the U key to unselect all selected items. You can select more than 1 item at a time. As you
select items the attributes of the most recently selected item will appear in the lower left side window in the tool. While an
item is selected you can left click on the Selected Information Box in the left corner to pull up the Item Attributes window.
Left Button with SHIFT held down – Selects everything within the box you create.
Left Button with CONTROL held down – Unselects everything within the box you create.
Right Button – Brings up a menu for copying, pasting and selecting.
Right Button with SHIFT held down – Click and move right or left to quickly zoom in and out of the map.
Right Button with CONTROL held down – Centers the map at the point you clicked on

Keyboard Commands:
Keypad 2,4,6,8 - Scrolls map down, left, right and up respectively.
Page Up, Keypad 9, Keypad Plus - Zooms map in.
Page Down, Keypad 3, Keypad Minus - Zooms map out.
INSERT - Toggles between Insert Mode and Select Mode.
DELETE - Delete selected items.
ALT – Hold to use hotkey listed in the toolbar menu. For example, pressing ALT + E pulls down the Edit Menu. After that,
pressing ALT + I will open the General Information window.
ARROW KEYS - Move the objects you currently have selected in very small increments. Using Control + Arrow keys will move 
objects in greater increments.
U - Unselects all selected items
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Screen Buttons:

C – Character Map – Press this button or the F1 key to show a full color representation of the terrain.
H – Height Map – This button and the F2 key will bring up a topographical view of the terrain where the lighter the color the
higher that part of the terrain. Solid dark areas are usually low, flat spots which is good for bases or airfields.
D – Depth Map – This view simply shows the contour map of the terrain. The closer the lines are to each other, the steeper
the grade. Solid black represents perfectly flat areas. You can also use the F3 key to see this map.
P1 – Page 1 – The Comanche 4 Mission Tool allows you to have two different missions open simultaneously.
This feature is good for comparing missions or for copying/pasting elements out of one mission into another.
P2 – Page 2 – Press this button to display the second mission that you opened. Note you must be on this page when you open
the second mission or it will replace your page 1 mission.
XY Coordinates – This gives you the grid location of the center of your screen. Click on this to type in new coordinates and
the screen will center on them. The units are in meters.
Layers – This option brings up a box that allows you to select which layers you would like to see and which ones are hidden.
See Section 4 for more information on Layers.
Unselect All – This button (or the U key) will automatically unselect all items.

Grid – Items that you insert while the Snap box is checked will move to the nearest grid
intersection. This is particularly useful when you want to line items up precisely. The View
box will toggle the grid overlay on and off. Use the Plus and Minus symbols to increase and
decrease the grid resolution (size).

Show – By checking the appropriate boxes, you can choose which items you see and
which are hidden from view. This is useful for finding specific items in a map full of various
item types.

Selected Information Box – When you select an item, its most important statistics appear
in the lower left corner of the screen. Click anywhere in this area to bring up the Item
Attributes window.

Usable Area - The red box on the terrain map displays the maximum size of the terrain.
Any items you place outside the red box will be forced to the inside edge of the red box
when you export that mission. The green box shows you the suggested area in which to
make your mission. Placing items outside of the green box may make the mission
excessively long.
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Section 2: Creating a New Mission
This section outlines the minimum amount you have to do to start making a mission for Comanche 4. The following pages detail
the more advanced instrutions. We recommend you go through this manual in order as some of the later steps are dependent on
the previous ones being set up correctly. Refer to Appendix C to see an example of a simple mission.

Step 1: Start the C4Medc.exe program. You can find it in your Novalogic, Comanche 4 folder.

Step 2: Select General Information from the Edit menu at the top of the screen.

Step 3: Select a Mission Terrain and Mission Type from the list. If you are making a single player game, you do not have
to make a selection. Now click “OK”. It may take a while for the new terrain to load.

Step 4: Zoom into the map until you see only four grid squares.

Step 5: Press the Insert key to enter Insert Mode, select a location for the player to start and left click the mouse.

Step 6: In the Insert Item window, select “Markers” in the left hand column, then “Start, Player” in the right hand column, then
click “OK”. This sets the point where the player will start the game. If you don’t place this marker, you won’t be able to get into
the mission!

Step 7: Press the Insert key again to change back to Select Mode and use the left mouse button to select the icon that you just
placed. Now click anywhere in the Selection Information Box on the lower left of the screen. This will bring up the Item Attributes
window for that object.

Step 8: Change the AI Variable Group to “1 - Blue Players” and change the Team to “Good (Blue)” then click “OK”.

Step 9: Go to the File menu and select Save to save your mission. The name you use to save will be the name that appears in the
game.

Step 10: Although you could export and play your mission at this point, it probably wouldn’t be very interesting. You are now ready
to begin placing enemies, setting mission events and determining mission goals. As you place them refer to the appropriate section
of this manual for more details.

Don’t forget to save your work often. Mission Designers will typically keep several back-ups of the files just in case they
make mistakes on their current file.
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Section 3: Editing General Information & Mission Briefings
Under Edit in the Tool Bar, select General Information to set the basic mission details.

Mission Designer – Put your name here.

Mission Terrain – Consult with Appendix A for a list of all
terrain available and select the one that best fits the loca-
tion of your mission.

Item Colors - Items choose from 3 different camouflage
styles: Green (for grassy terrain), Brown (for desert terrain),
or White (for snow terrain). Choose the one most appropri-
ate for your mission. All items with multiple camo settings
will use the one color selected here when the mission is
exported.

Default Equipment – Select the loadout that is most
appropriate for the player in your mission. The player
will be able to change this gear at a FARP once a mission
has begun.

(Note: Be sure to place a FARP at the player’s starting point, or they won’t be able to change their loadout.)

Air Strikes - The number in this box determines the number of artillery strikes available in the mission.

AWACS RADAR - This allows the player to recieve additional targeting information on their HMD from AWACS planes. Objects that
cannot be seen by the Comanche’s sensors, such as those behind a hill, will now appear.

Map Type – Select what type of mission you are making. For single player missions, do not select anything.

Terrain Overrides – You can raise the water level in your mission (measured in 1/2 meters). We recommend that you do not go
over 130 for most maps or the entire mission may take place underwater. If you want fog in the mission, select its level here (1-7).
0 is off, 7 is extremely thick and 1 is so thin it appears as an overcast day. Between 4 and 5 is best for missions with fog. You can
also alter the color of the fog by manually setting the Red, Green and Blue settings. Fog is best when Gray (50,50,50). Other exam-
ples of colors:

Bright Red = 255,0,0 Yellow = 0,100,100
Medium Green = 0,120,0 Black = 0,0,0
Dark Blue = 0,0,25 White = 255,255,255

Be sure to click the box next to each selection to enable it.

Sky Settings – With these settings, you can add weather effects such as rain or snow and set the position and brightness of the
sun or create a night mission. Be sure to check the Night box in addition to selecting a night sky, as this will properly adjust cer-
tain art elements.

Win and Lose Conditions – You can set up to eight win or lose mission goals in this area. The win and lose conditions are for goal
information text only. The actual win and lose conditions are set up through the events (see page 10).

Score -  When a win or lose condition is met, the player will be awarded however many points you enter into this box.

Wind Settings – If you want wind to play a part in your mission, set the wind speed and direction here.
Light Wind = 25 kph, Heavy Wind = 50 kph, Hurricane Wind = 90 kph
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Section 4: Groups and Layers
The most important part of building a good mission is organization. You can quickly get lost in a sea of meaningless numbers
unless you take the time to properly label things. A little work in the beginning saves a lot of headaches later on.

Groups 
Groups are used to classify related items such as a
squad of enemy helicopters and set an identity for
Events and Waypoints. It is often better to give each
unit its own orders so that it doesn’t interfere with
other units. However, placing multiple units in a group
may save you time setting up the mission. You can
rename the group to any name you want and
automatically select all units within a group from
the Group window, under Edit. Click Save As to
save the list to a text file. Print out this file for easy
reference. You’ll be glad you did.

Layers
Layers are vital to sorting out all of the items within a mission.
You can create up to 32 individual layers for sorting. Under
the Edit menu, you can change the Layer Names to whatever
has meaning to you. Some examples of names are Enemy
Base, Friendly Waypoints, and Foliage. When you just want to
see a certain layer of items, hit the Layers button on the main
screen and check the ones you want to see.
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Section 5: Waypoints
Waypoint groups tell vehicles and soldiers where to go. Set up
Waypoints under the Edit menu. Again you can name a waypoint
group with whatever name you chose. Waypoint Size show’s how
many individual waypoints are part of a waypoint group. If you check
the “Waypoint does not loop” checkbox, then the vehicle will come
to a stop at its last waypoint. Otherwise vehicles reaching their last
waypoint will attempt to head back to their first waypoint and start
again. You place waypoints (found under Markers in the Insert Item
window), as you would insert other objects. Click Save As to save
the list to a text file for printing.

Placing Waypoints
A waypoint is designated by 2 numbers, such as waypoint 1-1 or 2-4. The number before the dash indicates its Waypoint List
number. The number after the dash indicates its Waypoint Number. Waypoints are numbered from 0 up, not 1 up. The
“reached waypoint” triggers follow this logic. So to the trigger, the second waypoint in a list is “1” no matter what they numbered
the object as.

Setting up a waypoint list:
1. Go to Edit in the menu and then select Waypoints
2. Select waypoint list 2. Click in the Description box and type “Enemy’s Waypoints”
3. Below that is a box to select a color for the lines connecting the waypoints. Select a color if you feel like it.
4. Below the Color box is a small check box. This determines whether or not your waypoint list will loop.

We don’t want our first waypoint list to loop. Click on it so that it is checked, then click OK.
5. Go to Insert Mode by pressing the Insert key.
6. Click on the map somewhere near your enemy to add the first waypoint.
7. In the Insert Item window, click on Markers then select waypoint.
8. Click somewhere else on the map to place your next waypoint.
9. Notice that Markers and waypoint are already selected. Just click on OK.

10. Repeat steps 8 and 9 a couple more times.
11. Get out of Insert Mode by pressing the Insert key.
12. Select all of the waypoints you just placed and then click on the Selection Information Box to bring 

up the Item Attributes window.
13. Change the Waypoint List box to “2 – Enemy’s Waypoints”. Click OK.
14. You should now see a series of connected lines. This is your waypoint list.
15. Unselect All with the U key.
16. Select your first waypoint and bring up the Item Attributes window.
17. Change the Number attribute (located near the bottom of the window in the center) to “0”. Click OK.
18. Now copy that waypoint and paste the copies along the route you want to be followed. Each one should get

numbered sequentially.
19. If the waypoints are all attached to the same waypoint name and are numbered correctly, you should see them connected 

by a line. If the line is incorrect make sure your waypoints are numbered in the proper order from 0 on up.
20. One last step: Get the enemy unit to follow this new path! Select the enemy unit and bring up the Item Attributes Window.

Under the Waypoints section, Select List “2 - Enemy’s Waypoints” like you did for the waypoints in Step 13. Click OK.
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Section 6: Inserting Items
After you have established some waypoint groups, you can begin placing items. Items represent everything your player can
encounter, from enemy vehicles and buildings to scenery such as trees and water towers. While in Insert Mode, left click to set a
new object down. This will bring up the Insert Item window where you can select the type and sub-type of item that you want to
place. Note that Markers include Player/team start positions, waypoints, and King of the Hill (KOTH) areas.

After placing an item, switch back to Select Mode by pressing the INSERT key and left click on an item. The basic statistics of the
item will come up in the Selection Information Box. Click on this area to open up the Item Attributes window.

While in the Item Attributes window, you can only alter attributes that pertain to the unit(s) selected. You will not necessarily need
to fill in every field available. Some fields will be grayed out, indicating that that option is not available for the current item. Note
that any attribute you modified will be changed for all items currently selected (where possible).

Social Security Number (SSN): The tool automatically sets this 
number when an item is placed. It represents the item number 
of the unit. Every unit has a SSN. The SSN is also used when you 
are triggering actions to happen to or happen because of that 
specific unit.

Layer: All units belong to a layer. Selecting an appropriate layer
will help you to better organize the mission. See Section 3 for
more information on Layers.

Position: This is the precise coordinates of where you placed
the unit on the map.

East = -X, West = X, North = Y, South = -Y
Above Ground/Sea Level = Z, Below Ground/Sea Level = -Z

Be sure to properly set the Height (Z value) if you want to put objects on top of other objects (like soldiers in towers). You will likely
need to adjust the second Z number to precisely place objects on tables and crates.

Absolute Height: With Absolute Height on, the Z value indicates height above sea level. With Absolute Height off, the Z value 
indicates height above or below the actual terrain at that spot.

Facing: This is used to change the direction an item is facing. It can be set from 0 to 360 degrees, with 0 representing North, 90
representing East, 180 representing South and 270 representing West. Pitch is the degree the object is pitched forward or 
backwards; something pitched at 90 will be pointed straight up rather than forward.

Remove if: This is used when changing the difficulty of a mission for multiple players. For example: If a 4 is placed in the Remove
If Less Than… field, that particular unit would only appear in that mission if more than four player were in the multiplayer game.

Sub-type: This designates what the object is. If you change the sub-type to a different object, the attributes you set for the initial
object sub-type will be retained.

AI Textfile - Chooses how the item will act. Each object should have an AI file designed and named for it. Make sure your Sub-type
and AI text files match or they may not act properly.
Target Camera Group: To make objects with multiple parts, such as a boat with a person on it, appear properly in your target
scope, you must assign both items the same number. Single units may remain set to 0.
Group: All Squads and Air Support are in groups. You can name groups whatever you want by clicking on Edit in the top left corner
of the tool and then clicking on Group.

Team: This designates good guys, bad guys and neutral guys. Red will target/attack blue and vice-versa whether marked as goals
or not. Neither blue nor red will target a neutral item.

Field of View: This tells you the extent that people and vehicles can see around them. 10 degrees would be like someone with
tunnel vision. A soldier with 360 degree FOV would have eyes in back of his head.

Engagement Distance - determines how close an enemy must approach before the selected item will engage the enemy.

Mission Critical - An item such as a building that is marked as mission critical will get a different symbol on the tactical map.

Alert State - Selects the items initial alert status. This status can be changed through the use of events and area triggers.
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Weapon Accuracy: This number represents how well the unit shoots. Lousy shots are 10 and under, good shots are around 30,
great shots are anything over 50. However, anyone will hit fairly quickly at close range. Also, the longer someone continuously fires
at a target, the more accurate they will get.

Perception: This is a rating of how well the AI can see, 30 is near sighted, 50 will notice most stuff at short ranges, 80 will notice
you across a valley.

NPC Primary Weapon: If the AI unit can hold a weapon, this is where you assign the type.

Waypoint list: This is where you assign groups to waypoints. You can name and organize waypoint lists the same as groups (Left
click on Edit and Waypoints). The number field is used to number waypoints. For King of the Hill Centers adjust the Distance to
increase the size of the hot zone.

AI Attributes: You can assign several different attributes to people or vehicles.

Neutral targeting: Allows neutral items to be targeted as though they were the enemy.

Hovering: Used for helicopters to put them into the air.
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Section 7:  Events and Area Triggers

Events
One of the most complex and powerful parts of the mission editing is creating events. With this tool, you will be able to set up a
series of actions that only occur when certain conditions are triggered. Each event is set up as an IF-THEN statement; in other
words IF a condition is met by the game, THEN the event takes place. An explanation of the trigger and event If-then statements
can be found in Appendix B

Here is an example of how to set up a win condition for Comanche 4. Say you wanted the player to win the game if they 
destroy a certain building:

1. While in Insert Mode, place a building on the map then return to SELECT MODE.
2. Return to Select Mode and select the building.
3. Right click the building with the mouse and click on Edit Item Attributes. Select a unique 

Group Number under AI Variables.
4. Open the Events window and double click on << New Trigger >> to open the Event Triggers window.
5. Select Group for the Trigger Type.
6. Select All Destroyed for Trigger Condition.
7. Under Trigger Variables select the building’s group # that you just placed then hit OK.
8. Now double click on << New Action >> to open the Event Actions window.
9. Select Blue Win for the Action Type.
10. Finally, for ease of identifying it, give the event a unique name at the top of the window such as “Win by destroying building”.

Reset after (seconds): Once this event has been
triggered, the mission can be set to automatically
reset the trigger after a specified number of seconds
has elapsed.

Delay (seconds): This is how many seconds must pass
before the actions will execute. 0 delay means that the
actions will be carried out as soon as the trigger 
conditions are met.

Area Triggers
An Area Trigger is used to set off an event when the
player, or any unit, enters a specified area.

To set an Area Trigger go to Edit and then Area Triggers.
Give a name to a trigger and click OK. Now enter Insert
Mode and place two Area Trigger icons. The can be found
under the Markers category.

Now double click on the info panel to open the Item Attributes screen. Under waypoints enter the number of the Area Trigger that
you just renamed and click OK A box will now appear using your two icons as corners. You may now set events by choosing Group
Area Trigger as your trigger condition.
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Section 8: Exporting and Playing Missions
Remember to Save your work often. When you are at a point where you would like to test your mission, go to Export Binary
Mission under the File menu. Your custom mission (.BMS file) must be located in the same directory as your Comanche 4 game
for it to be seen by the program.

You are limited to the number of different types of items you can have in one mission. When you export, the tool will indicate if you
have too many different items.

The following Warnings can show up when exporting the file:

• The total number of Decorations and Buildings (X) exceeds the maximum (1024)

• The total number of Vehicles and Objects (X) exceeds the maximum (1024)

• The total number of Markers (X) exceeds the maximum (512)

• The total number of People (X) exceeds the maximum (256)

The file will still export, but only the first Y objects of that type will be exported  (Y being the maximum number allowed for each
category). The number of objects should be reduced to the limit or unpredictable things could happen as a result of the excess
items not being exported.

To play your custom mission, start your Comanche 4 game. In the Single Player Archive Missions or Multiplayer Hosting
Screen (depending on the type of mission you created), select your mission from the list of games.
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Section 9: Hints and Tips

• Plan out your mission before trying to create it in the Mission Editor. Having a good idea of what you want your mission to con-
tain will make your work go much more efficiently.

• For your first mission, open the sample.mis mission and begin tweaking aspects of it. This mission was created to give you
a head start on creating a mission. Looking at how a mission designer lays things out may help you understand specific

portions of a working mission.

• For ease in viewing units, use the Height Map view (F2 key). The items will stand out more against this background.

• Using the layering functions can help save a lot of time when fine tuning missions. Putting items in Layers may seem like a
hassle for smaller missions, but when more and more items are added, you will really wish that you had done it.

• When you right click the mouse with no items selected, you can choose to View by Side; this will turn all of the bad guy’s
items red, all of the good guy’s items blue and all of the neutral items green for ease of game balancing.

• The best method for laying down waypoints is to insert one, change to select mode, set its waylist group, and change its 
distance to 0 (this causes people to follow the path exactly). Then copy that waypoint and paste it where you want the next to
be. The waypoint numbers should automatically update in the order that you place them.

• When placing buildings, use the F3 view to find a good flat spot.

• In Capture the Flag missions, it’s a good idea to drop a “null” marker on top of any flag you put down, then set the null 
marker to the team color of the flag. This allows you to see your flags from a zoomed out perspective, where they’d normally
be hard to see.

• A good rule of thumb for placing objects is whenever you want to place an object which has others like it already in the 
mission, it’s simpler to copy and paste it, then modify the new one (rather than switch to insert mode and create a new one).

• When moving vehicles, remember to set up an event with both “change group velocity” and “redirect group to waypoint”.

• You can rotate several objects at the same time by selecting them, right clicking and selecting “Group Rotate” from the list.

Save, export and test your mission often! 
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Appendix A: Terrain Types

There is a pull down menu for your mission terrain in the General information window. Each image on this page represents the
land and climate type for each of the missions listed at the bottom of the page. Each selection will have a different configuration of
landmasses, so look through them to find the one that suits your design. The letter indicates the terrain type (d=desert, g=grass, s-
snow).
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Appendix B: Trigger List

“IF” Statements
Trigger Types

Null: Always False. Can be used as a temporary placeholder.
Group: Triggers affected by Groups. Needs a Trigger Condition (below).
SSN: If the specified unit performs the trigger, the event will take place.
Event: True if the Event has been triggered.
2ndTime: True if this is the even numbered time the mission is played.
SquadMates: True if Squad Mates are “on”.

Group Trigger Condition
Null: Nothing. Can be used as a temporary placeholder.
Has Targeted: True if Group X has targeted Group Y.
Group Shot Enemy: True if Group X shot at and hit Group Y.
Condition Red: True if Group has been alerted of the enemy presence.
Condition Yellow: True if Group has been put on yellow alert.
All Destroyed: True if all members of the Group are killed/destroyed.
Any Alive: True if any members of the Group are still alive. This will trigger immediately unless other conditions are set.
Lost X Units: True if X number of units in Group have been killed.
Group Reached Waypoint: True if Group reached waypoint.
All intact: True if Group has suffered no casualties.
Group Holds Item: True if Group is holding the specified item.
Has X Units: True if Group has X or more members alive.
Group Shot Enemy SSN: True if Group X shot at and hit a specific target.
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“THEN” Statements
Action Types

Null: Always False. Can be used as a temporary placeholder.
Redirect Group To: Make Group go to Waypoint X-X.
Kill Group: Immediately kill all members of Group.
Change Group AI: Change an AI attribute of Group (See AI subtypes below) to “On” or “Off”.
Vaporize Group: Remove the Group from the game.
Blue Win: Blue wins!
Red Win: Red wins!
Sub Goal Won: The sub goal has been accomplished.
Sub Goal Lost: The sub goal has been lost.
Group Change Team: Orders a group to switch sides.
Group Change Group: Orders a group to change to another group.
Group Teleport: Instantly moves a group to a specified teleport target.
Redirect SSN To: The specified unit will move to a specified point.
Kill SSN: Instantly kills a specified unit.
Change Single AIl: Changes the behavior of a specific unit. (see Action Subtype AI, below)
Vaporize SSN: Takes a specific unit out of the game completely
SSN Change Team: Allows a single unit to change sides
SSN Change Group: Allows a single unit to change groups
Teleport SSN: Instantly moves a single unit to a specified teleport target.
Create Particle effects: Creates a particle effect at a specified teleport target.

Action Subtype: AI
Null: Nothing. Can be used as a temporary placeholder.
Red Alert: Be alert for enemies.
Yellow Alert: Heightened state of awareness.
GreenAlert: Everything’s clear.
Driver’s Skill Level: Alters the drivers skill level up or down.
Gunners Skill Level: Alters the drivers skill level up or down.
AI State: Changes the alert status of the unit to green, yellow or red.
Combat Speed: Alters the speed of a unit’s speed when engaged in combat maneuvers.
Patrol Speed: Alters the speed of a unit’s speed when not engaged in combat.
Target SSN: tells the unit to target and attack a specified unit.
Use Waypoint Z: Forces aerial units to stay at their preset altitude.
Stop Using Waypoint Z: Allows aerial units to go to any altitude their AI takes them.
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Appendix C: Sample mission

With the Comanche 4 Mission Editor open, select File, then Open, then select the “Sample.mis” file. This mission was built for
you to have a head start on designing a mission. You can also use it to deconstruct how a NovaLogic Mission Designer builds
a mission.

The tutorial terrain is in the desert on an overcast and rainy day.

A - Towards the bottom of the map is the starting
position for the player. A "Start, player" icon as 
well as a "FARP" icon have been placed here. The
orange lines is the Waypoint path that the player is
to follow.

B - Above the player start is the enemy base. It's
protected by an SA-8 SAM launcher, two anti-air 
cannons and a few soldiers. All of these units are in
the "Resistance" group. Eliminating them all is a
requirement for winning. Also at the base are two
trucks that are part of a group called "Trucks 1".
The tent and tower are part of the "Structures" group.

C- Finally we have the "Reinforcements" group 
comprised of two armored vehicles and three supply
trucks that make up the  "Trucks 2" group.

There are 5 events that occur in this mission:

1 - Red Alert - When the player crosses into the blue box, it sets off an area trigger that changes the Resistance units 
AI to Red Alert. This makes them more attentive to attacks, and faster to fire back.

2 - All supply trucks destroyed - When the player destroys the trucks in
Trucks 1 and Trucks 2, a sub goal is accomplished.

3 - Destroy all buildings - The player must destroy the tent and the
tower before completing the mission.

4 - Eliminate resistance - When the player eliminates all units in the
"Resistance" and "Reinforcements" groups, the subgoal is won.

5 - Reach final waypoint - After everything is accomplished the player
must reach the final waypoint to end the mission.

Trying changing some variables of this mission, export it and play through it to see your changes. It will appear in the
Quick Mission list.
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